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1. What is Database? 

 

When a collection of data is small and simple, you can keep track of the entire information 

with simple lists. However, as the volume of information grows, you need a more efficient 

way of storing, processing and retrieving data. If you want to maintain the information and 

be able to access it at snap of your finger, Microsoft Access data base management system 

is the product of use. 

 

A database is a systematic organization of data for easy retrieval. Employee records in the 

file cabinet, a stamp collection in an album, and a collection of sales in a notebook are 

collections of data called database. A database may be created and maintained manually or 

it may be computerized. A computer database is created and maintained by a database 

management system (DBMS)  

 

A database management system is software, which is used to create, store, modify and 

access data in a database. A database management system serves like a bridge between the 

user and application programs.  

 

2. Components of DBMS 

 

 

The components of DBMS may vary, but the most common are: data dictionary, data 

language, Security software, archiving software, and query languages. 

 

Data dictionary: contains the names and descriptions of all data elements in the database. 

Data languages: are languages used to enter data element‟s name and description in a 

dictionary, and manipulate the database. The language that is used to define the 

data is called data definition language (DDL), and the language used by 

programmers to Manipulate data from a database is known as a data base 

manipulation language (DML). 
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Security software: is a collection of programs, which protect a database from unauthorized 

access. 

Archiving programs: are programs used to create copies of the programs and database in 

case of emergency. 

Query language: are set of commands that are used to create, update and retrieve data from 

a database. One of the most popular standard query language is SQL 

(Structured Query Language).       

 

 

3. Types of DBMS 

 

 

Based on the internal structure of data and their relationships, DBMS types are divided in to: 

 

1. Hierarchal Model. 

2. Network Model. 

3. Relational Model.  

4. Object oriented model. 

5. Deductive or Interface Model. 

 

But the main topic of discussion in this course is relational model. 

 

 

4. Relational DBMS  

 

 

The relational model is the most popular type of DBMS which organizes data in terms of 

tables, each data having their own fields and relate them through a key field are called 

Relational Database Management System (RDBMS). 

 

Microsoft Access is one of such RDBMS that provides standard database management 

features for data storage and retrieval. 
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5. What is Microsoft Access?  

 

 

Microsoft Access is a relational database management system, which allows the collection, 

organization, relational analysis, and presentation of information. Like most RDBMS, 

Microsoft Access enables you to create and manipulate database but with easy of use and 

being more powerful. 

Applications that can be developed using Microsoft Access includes the following among 

others: 

 

 Sales order processing.  

 Inventory management. 

 Library system. 

 General Ledger. 

 Account payable/receivable. 

 Bill scheduling.  

 Data analysis.  

 

 

6. Access Database  

 

 

An Access Database (i.e. a database created by Access) is a collection of one or more files 

(called database objects) treated as a whole. MS-Access database objects are: tables, forms, 

queries, reports, macros and modules. 

      

Tables: A table is a fundamental building block of an access database. All databases must 

have at least one table, because this is where the data is stored. Tables are grids of 

rows and columns. Each column in a table is called a field. Each field contains a 

specific type of information such as first name, last name, phone number, etc.  
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Queries: a query is a filter through which data is evaluated. You can define a filter criterion 

in a query and only those records, which meet this criterion, are displayed. 

Forms: are used to simplify data entry work or to display information in a specific manner 

(or form) like columnar, tabular, data sheet, main/sub form, chart or pivot table 

form. Forms let you add, modify, and delete database data.  

Reports:  A report summarizes data in a format suitable for publishing that is to view data 

on the screen or to print it on a printer or to publish it on the web.  

Reports are used to present data in a meaningful and attractive manner and here 

you can combine data, charts, images, and even audio and video. 

Macros: is used to automate repetitive tasks. Basically any operation that you do over and 

over again can be automated by creating a macro, so that a click of a button or by 

pressing a particular key, an entire sequence of commands can be executed. 

Modules: For most of your simple repetitive tasks, you can create macros and simplify your 

work. However, if you want to develop a full-fledged software application 

(package), which automates a wide variety of complex tasks, you should create a 

visual basic for application (VBA) module. For larger and complex projects, VBA 

gives you considerable flexibility, control, power and maintenance that is just not 

possible by writing simple macros. 

 

7.  Starting MS-Access 

 

There may be several ways you can use to start MS-Access, depending on the configuration 

of your computer. But the most straight forward way to start MS-Access is: 

 

1.Click the Start button. 

2. Point to All Programs. 

3. Click MS-Access. 
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8.  Creating a New Database  

 

When MS-Access starts, the first thing you see is a dialog box prompting you to create a 

new data base using Blank Access database, Access database wizards or open an existing 

one.  When MS-Access starts, the following dialog box will be displayed automatically. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select the Blank Access database to create a new customized database.  

 Select Access database wizards, pages and projects to create a new database 

with the help of wizard. 

 Select Open an existing file, then click on the file you want from the list to open 

an existing database.  
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9. Creating a Database 

 

Prior to using MS-Access to actually build the table, forms and other database objects that 

will create your database, it is important to take time to design your database. A good 

database design is a keystone to create a database that does what you want it to do 

effectively, accurately and efficiently. While planning for a database, keep the following 

points in mind.   

 

A. Define the purpose of your database and how it is used. Consider the present and 

future questions (queries) you may want to answer from the stored data. Example, if 

you want to run a query on the customer‟s database, to generate state wise and city 

wise lists, create two separate fields for city and state instead of one address field. 

B. Determine the tables & the sizes and types of fields in each table. Once you have 

a clear purpose for your database, and got some hint about the information that that 

should be stored, you can divide the information in to separate tables. Each table 

must contain information only about one subject like customers or items.  

C. Determine the fields you need in each table: To determine the fields in a table, 

decide what you need to know about people, things or events recorded in the table. 

For instance, information that is needed to be known about the customer is: their 

name, address (such as telephone, P. O. Box, city) and facts that needs to be known 

about transaction is: person who made the transaction, item number, unit price, 

quantity and data of transaction. When sketching out the fields for each table, keep 

these tips in mind. 

 Relate each field directly to the subject of the table.  

 Do not include derived or calculated data (data that is the result of the 

existing data. 

 Include all information you need. 

 Store information in its smallest logical parts (example, store first name and 

father name separately, rather than as full name together).  
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D. Determine fields, which uniquely identify the record in a table, such a field is 

known as the primary key field. For example the ID number of two students in the 

same school cannot be the same. Therefore, the ID number field can serve as the 

primary key field in the student‟s table. 

 

E. Determine the relationship between tables. A relationship works by matching the 

data in two different tables using a common primary key field. There are three kinds 

of relationships: One-to-One, One-to-Many and Many-to-Many. In a one to one 

relationship, for one record in a table A there is only one corresponding record in 

table B .In one-to-many relationship, for each record in a table A there are many 

records in a table B. In many-to-many relationship, for each record in table A, there 

are many records in table B and for each record in table B, there are many records in 

table A. 

 

F. Refine your database. After you have designed the tables, fields and relationships 

you need, it is time to study the design and detect any flows that might remain. It is 

easier to change your data base design now, rather than you have filled the table with 

data. 

 

G. Add data and create database objects. When you are satisfied that the table 

structures meet the design goals described above, then it is the time to get a head and 

add all your existing data to the tables. You can then create any queries, forms, and 

reports that you may want. 

 

MS-Access provides two methods to create a database: 

 

I. Access database wizards: to create in one operation the required tables, forms, and 

reports for the type of database you choose; this is the easiest way to start creating your 

database. 
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 To create a new database using Access database wizard: 

1. If you started Access, and the MS-Access dialog box is still on screen, click 

Access database wizard radio button, and click Ok. Or if you have already 

closed the dialog box, select file, New. 

2. Click Database tab, to display the list of wizards.  

3. Click one of the Access database wizards you want to create. When you click on 

the wizard, a preview appears in the preview area. 

4. When you find the wizard you want, click Ok. The File, New dialog box 

appears. 

5. Type the name and the location for the database and click, Create to start 

defining your new database. The wizard starts and some information appears 

explaining what the wizard will do.  

6. Click Next to continue. A list of tables to be created appears on the left, and the 

selected table‟s field appears on the right. 

7. Click a table you want and examine its lists of fields. Optional fields are in italic 

and are deselected. To include an optional fields put the check mark in its check 

box. 

8. Click Next to continue. The wizard asks you what kind of screen display style 

you want. Choose the one that you need. 

9. Click a display style you want in the list and examine the preview of the style 

that appears. When you have decided on a style, click it and click Next. The 

wizard asks you for a style for printed reports. 

10. Click a report style and examine the preview of it. When you have decided on a 

style, click it and click Next. 

11. The wizard asks what title you want for the database. The title will appear on 

reports, and it can be different from the file name. Enter a title. If you need, you 

can include picture by checking Yes, I I’d like include a picture check box, and 

clicking picture button. 

12. Click Next to continue.  

13. When you get to the finish screen, click Finish. 
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The wizard starts creating the database. When the wizard is finished, the main 

switchboard window appears. The main switchboard lets you perform common 

tasks with the database by clicking a button the switchboard opens automatically 

whenever you open the database. 

 To prevent the switchboard from opening whenever you open the database 

1. Select the Tool, Startup. 

2. Open the Display from drop down list and select (None). 

3. Finally select Ok. 

II. Blank Access database: you can create a blank Access database and then add the table, 

forms, reports, and other objects later. This is the most flexible method, but it requires 

you to define each data base element separately. 

 To create a New database using a Blank Access database: 

1. Start MS-Access. 

2. Click Blank Access database radio button. 

3. Click Ok. 

4. Choose the folder or drive where you want to save your file in.  

5. Give the name of database in the File name textbox.  

6. Click Create button to create a new database. The following window would be 

displayed. This window is commonly known as Main Switchboard. It provides 

buttons to enable you to use the database easily. 
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9. Tables  

 

The heart of each database is its tables. Access stores each database entry (such as each 

customer or each products item) in its own row, which is called a record. Each type of detail 

is kept in its own column, which is called a field. For example, Customers ID are one field, 

and Company Name is another. Each database files can have many tables like customers, 

employees, product, and sales, tables. All other database objects such as queries, forms, and 

reports depend on data stored in table (s). Hence, before creating other objects for your 

database, you must create tables. 

 

9.1 Creating Tables   

 

If there are other databases from which you can take some of the table, there is the Import 

table option. If not you will have to create a custom designed table, use the table wizard, or 

by entering data. 

 

A. Creating a Table with the Table wizard  

 

If the fields you want to create are similar to any of the access‟s dozens of          pre-made 

ones, the table wizard can save you a lot of time and effort. Creating tables through the table 

wizard is much faster and easier than through design view and by entering data. However, if 

you use wizards, you are some what restricted with the pre-defined settings already 

available. 

 

 To create a table using the table wizard: 

1. Start MS-Access, if you are not in the Access program.  

2. Select Insert, Table from the menu bar along the top of the screen. Or                 

in the database window, click Table tab and click New. The new table dialog 

box appears.  

3. Click Table wizard and click Ok.   
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4. Click a table in the Sample Table list. Access then displays its list in the sample 

field‟s list. 

5.  If you see the field that you want to include in your new table, select it in the 

Sample Field lists; then click > button to move it to the fields in My new table 

list. To move the entire content of the selected sample table to your list click >> 

button.  

6. Repeat steps 4 and 5 to select other fields from other sample table until the list of 

the field in your new table is complete. You can remove a field or all the fields 

from the list by clicking < or >> button respectively. When you finish adding 

fields, click Next to continue.  

7. The wizard asks for a name for the table. Type the more descriptive name to 

replace the default one.  

8. Click Yes, Set a primary key for me to have the wizard choose your primary key 

field, or No; I will set the primary key to do it your self. 

If you choose Yes, skip to step 9. If you choose No, a dialog box appears asking 

which field will be the primary key. Open the drop- down list and select the field. 

Choose a data type for the primary field: 

 Consecutive numbers MS-Access assign automatically to new 

records. Choose this, if your primary key field is simple record number. 

That is, if you are numbering the record you enter consecutively as you 

enter them. 

 Numbers I enter when I add new records. Choose this, if you want to 

enter your own number. Access will not allow you to enter any letter.  

 Number and /or letter I enter when I add new records. Choose this, if 

you want to include both number and letter in the field.  

9. Click Next.  

10. At the Finish screen, click one of the following options: 
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1. Modify the table design. This takes you in to Table Design View, the same 

as if you had created all those fields your self. Choose this option if you have 

some change you want to make the table before you use it. 

2. Enter data directly in the table. This takes you to Table Data sheet View, 

where you can enter records into the row of the table. Choose this, if the 

table‟s design seems perfect to you as it is. 

3.  Enter data in to the table using a form the wizard creates for me. It leads 

you right in to the form wizard.  

11. Click Finish. Now it is the time to start entering the data into this table. 

12. Click on Close button to close the table you have created. 

13. Click on Yes button, to save the change you have made to your table. 

 

B. Creating Table by Entering Data 

 

This method is used if you want to insert your field and data directly in to the task. 

 

 To create a table by entering data: 

1. Select Insert, Table or from the database window, click Table tabs and click 

New. 

2. Click Datasheet View to create table by entering data, Click Ok. 

3. Start entering data in to the table. As you see the columns are named as Field1, 

Field2, and so on. To make things simpler and easier to understand, rename the 

columns. 

  

 To rename the columns: 

1. Click on the column you want to rename.  

2. Click Rename column from the Format menu, or double click on the column 

headings you want to rename.  

3. Type the heading that you want when the cursor is placed on the column 

headings.  
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4. Save the database. 

 Choose save command from the File menu.  

 Give the name of the new table in this box.  

 Click Ok. 

 Since you have not defined the primary key, a dialog box comes that 

prompts you to do so. 

 Click Yes, to define a primary key. 

  You could still enter records into this database or close it now to close this 

database. 

 

C. Creating a Table in Design View 

 

First you plan and create your database structure, identifying which all fields are 

required, which fields will contain what type of data (numeric, alphanumeric, data etc) 

and what will be the maximum width of each field. Once you have decided this 

structure, you can then create a table in the design mode (where you have to specify each 

and every thing your self). 

 

 To create a table in Table Design View:  

 Select Insert, Table or, from the database window, click the table tab and click 

New. 

 Click on Design view and click Ok. 

 Or simply click on Table and double click on Create table on Design view. 

Here the table design view window is divided in to two parts. The upper part is 

divided into rows and three columns: Fields Names, Data type, and 

Description. Each row is used to write the name, to see data type, and to write 

some additional description of the field if necessary. The lower half is the field 

properties pane. Once you have named a field and set the data type, you can use 

the lower pane to set some additional field properties to determine the nature of 

the table. 
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 Type the field name in the Filed Name column, the press Tab Key to move the 

data type column. 

 When you move to the Data Type column, a down ward arrow appears. Click it 

to see the drop-down list and select the data type.  

 Press Tab key to move the Description (which is optional) column and type of a 

description of the field.  

 In the Field properties pane, make any change as you need  

 Repeat step 4 through 6 for other fields. 

 Click Close (X) button. 

 When you are asked to save the change, click Yes and type the name of the table 

on the Table name text box. 

 Click Ok. 

 

9.2 Understanding Data Types and Formats  

 

For each field to be included in a table you are expected to specify Field name, Data type, 

and Description, which is optional. 

 

1. Field Name: is the name by which the field is identified. Microsoft Access field names 

can be up to 64 characters long and can include any combination of letters, 

numbers, spaces, and special characters except a period (.), exclamation mark (!), 

an accent grave („), and square brackets ([]). Also field names must not start with 

space.  
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2. Data Type: Each field must have a type so that Access will know how to 

handle its content. Here are the types you can choose from.  

Text: plain ordinary typed text, which can include numbers, letters and symbols. A 

text field can contain up to 255 characters. 

Memo: More plain ordinary text, except this, one does not have maximum field 

length. So you can type an almost infinite amount of text (64,000 characters). 

Number: a plain ordinary number (not a currency or date value). Access will not 

allow any text in a number field. 

Date/Time: to store date and time. 

Currency: a number formatted as an amount of money. 

Auto Number: a number that Access automatically fills in for each consecutive 

record.  

Yes/No: the answer to true/false questions. It can contain either of two values, which 

might be Yes or No, True or False, ON or OF 

OLE Objects: Enables you to store documents, spreadsheet, graphics, drawings, 

sound and other information created in MS-Window applications. 

Hyperlink: A link to a location on the World Wide Web. 

Lookup Wizard: Lets you create a list to choose a value from another table or list of 

value in a combo box for each record. 

 

3. Description: is an optional descriptive text that you can add for a field you create. This 

description will appear down at the bottom of the Access start up window when the 

field is clicked A description can be used as a guide line for user, and its length can 

be up to 255 characters long including space. 

  

9.3 Setting Field Properties  

 

In addition to a data type each field have formatting options you can set. They appear at the 

bottom half of the dialog box in the field properties area. Properties you can set for field are 

dependent on its data type. 
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Field size: The maximum number of character a user can in put in that field. 

Format: A drop-down list of the available formats for that field type. You can also create 

custom formats of your own. 

Decimal Places: For number fields, you can set a default number of decimal places so a 

number will show. 

In put Mask: Formatting character for data entry specially used when the data entered in 

the field has pre-defined masks or customize your own.  

Caption: Field liable to be used in a form or report. 

Default Value: If a field is usually going to contain a certain value, you can enter it here to 

save time. It will always appear in a new record and you can type over it in rear 

instance when it does not apply. 

Validation rule: Are expression used by Access to determine whether or not an item 

entered in a field should be stored as a value.  

Validation Text: That appears when invalid data is entered in to a field. 

 Required: Choose Yes or No o tell Access whether a user should be allowed to leave this 

field blank, when entering a new record.  

Allow Zero Length: setting this defines whether zero length strings are permitted. 

Indexed: When this property is to Yes for a field, Access creates and maintains an index of 

values entered in to the field so that it could be accessed faster than any no indexed 

field. 

 To set the field property: 

1. In the Table Design Window, select the field for which you want to set properties, 

Access displays the properties for this fields in Field properties panel.  

2. Click the property you want to set at the Field properties panel.  

3. Set the property. If an arrow appears to the right a property box when you select a 

property, you can click the arrow and select from the list. If Build button appears, 

you can click the button to have the builder help you set the property. 

4. Repeat step 1-3 for each field you want to set property. 

5. Finally click Save button on the Tool bar.       
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Note: It is always a good idea to limit a field size to the smallest setting you need, since MS-

Access works faster with smallest field sizes. 

 

9.4 Modifying a Table 

 

No matter how you create you table, you can modify it using Table Design View: 

 

 To enter table design view:  

1. From the Database Window, select the table you want to modify and click the 

Design button or,  

2. If the table appears in the Data sheet view, select View, Table Design, or click 

View button from the standard tool bar. 

 

 To Delete Fields: 

1. In Table Design window click on the row selector (found at the left of the field 

name you want to delete) of the field.  

2. Do one of the following: 

a. Press the Delete key on the keyboard.  

b. Click The Delete Rows button on the Toolbar. 

c. Select Edit, Delete Row.  

 

 To rearrange order of fields: 

1. Click on the Row selector of the field name you want to move to another 

position. The Row selector shows a small triangle.  

2. Click the Row selector again, and drag it to a new position. 



Microsoft Access Training Manual 

Prepared by: 
                      Tewelgn Kebede 

 

 

9.5 Copying and Moving Database Objects    

  

1. In the database window, select the Object.  

2. Open the Edit menu and select Copy (to copy) or Cut (to move) or click Copy 

or Cut button on the standard tool bar. 

3. If you are coping or moving the object in to different database, close the current 

database and open the database into which you want to paste the object.  

4. From the Edit Menu, choose Paste.  

 

9.6 Setting the Primary key 

 

Microsoft Access works most efficiently if you specify a primary key. The primary key of a 

table consists of one or more fields that uniquely identify each record you store in the table. 

A primary key is often an ID number or code, since these types of value is always different 

from each record. You should always specify a primary key for the table. A table with a 

primary key has the following advantages. 

 

 Microsoft Access creates an index for the primary key. This index helps speed up 

queries and other operations.  

 When you view records in a form or data sheet, Microsoft Access displays them in 

primary key by default. 

 When you add data to your table, Microsoft Access does not allow record with the same 

primary key value as another existing record. Because of this, you can be sure that each 

record is uniquely identified.  
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 To set the primary key: 

a. Click the field that you want to use for the primary key. To create a multiple field 

primary key, hold down the Ctrl key and click the field selector to the left of 

each field that you want to include. 

b. From the Edit menu, choose Set Primary key, or click the Set primary key 

button from the tool bar. Microsoft Access adds a key indicator to the left of the 

field or fields you specify as the primary key.  

 

 To remove a primary key: 

1. Open the table in Design view.  

2. Click the row selector for the primary key. 

3. Click Primary key on the tool bar. 

4. Save the table.  

 

Note: If the primary key is used in a relationship, you must delete the relationship before 

you remove the primary key. 

 

9.7 Relationships between Tables  

 

After you have set up different tables for each subject in your database, you need a way of 

telling MS-Access how to bring the information back together again. The first step in this 

process is to define relationship between your tables. After you have done that, you can 

create queries, from and report to display information from several tables at once. A 

relationship works by matching data in key fields, usually a field with the same name in both 

tables. In most cases, these matching fields are the primary key (one or more fields that 

uniquely identify each record in a table) from one table and foreign key (one or more table 

fields that uniquely identify each record in other table) in other table. There are three 

possible types of relationships. 
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1. One-to-One Relationship: In this relation ship, each record in each table is related to 

exactly one record in the other table. This type of relationship is not common, because it is 

more natural to have more than one matching fields. 

 

2. One-to-Many relationship: In-one to-many relationship, a record in one of the tables 

(say the first table) can have more than one matching records in the second table, but a 

record in the second table have only one record in the first table matching it. This is the most 

common type of relationship.  

 

3. Many-to Many Relationships: In this case, a record in the first table can have many 

matching records in the second, and a record in the second can have many matching records 

in the first. 

 

 To create a relationship between tables: 

1. Close any table you have opened. You can‟t create or modify relationship between 

open tables. 

2. If you haven‟t already done so, switch to the Database window. 

3. Click Relationship on the toolbar or from Tools menu. The relationship windows 

will be displayed. 

4. If you need to add the tables you want to relate and the Add Table dialog box is not 

displayed, click Show Table on the toolbar. If the tables you want to relate are 

already displayed, skip to step 6. 

5. Double-click the name of the table you want to relate, and then close Add 

Table/Queries dialog box.   

6. Drag that you want to relate from one table to the related field in the other table. 

7. From the Relationships dialog box, choose any referential integrity option you want.  

8. Click the Create button to create the relationship. When you close the Relationships 

window, Microsoft Access asks you if you want to save the layout. Whether you 

save the layout or not, the relationships you create are saved in the database. 
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 To view existing relationships: 

1. Switch to the data window.  

2. Click Relationship on the tool bar. 

3. To view all the relationships defined in the database, click Show All 

Relationships on the toolbar. 

4. To view only the relationships defined for a particular table click the table, and 

then click Show Direct Relationships on the tool bar  

 

 To delete a relationship: 

1. Close any table you have opened. You can‟t delete a relationship between open 

tables. 

2. Switch the Database window, if you don‟t already do so. 

3. Click Relationships on the tool bar.  

4. Click the Relationship line, for the relationship you want to delete (the line will 

turn to bold when it is selected) and then press the Delete key. 

 

9.8 Referential Integrity 

 

Once a relationship is created, certain operations like deleting some records, changing some 

values in some records, or adding records in some tables could accidentally damage data. 

This could affect the validity of relationship. Referential integrity is a set of rules, which 

does not allow the accidental deletion, or modification of data in the related tables by 

reminding you the consequences of your action on the related tables. If you delete records or 

change primary key values in a primary table, Microsoft Access makes necessary changes to 

related tables to preserve referential integrity. 
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9. Queries 

 

The real power of database is the ability to see the data you want; in the order you want to 

see it. A query is a database objects that you create to look for particular information in the 

database. You use queries to view, change, and analyze data in different ways. With queries 

you can: 

 Choose Fields: you don‟t have to include all of a table‟s fields in your query. 

 Choose Records: You can specify criteria that records must meet to include in the 

result. 

 Sort Records: you can view records in a specific order. 

 Ask questions about data in several tables: You can use a query to answer a question 

about data from one table and see the result in a single datasheet. 

 Perform Calculations: You can create new fields that contain the result of a calculation 

called calculated fields.  

 Use as a source of data for forms, reports and other queries: To select just the right 

data to display in a form or report, you can create a select query and then use that 

query as the source of data for the form or report. 

 

10.1 Types of Queries 

 

In Microsoft Access, you can create different types of queries each designed for a certain 

purpose. 

 

A. Select Query 

 

A Select query retrieves data from one or more tables and displays the result in a datasheet 

where you can update the records (with some restrictions). You can also use a select query 

to group records and calculate sums, counts, averages, and other types of totals. Microsoft 

Access‟s default query is select query since it is the most common type of query. 
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 To create a simple select query with Query Wizard: 

1. In the Database window, click the Queries tab, and then click New. 

2. In the New Query dialog box, click Simple Query Wizard. 

3. Click Ok. The Show Table dialog box is displayed. 

4. In the Tables/Queries drop-down list, choose the table from which you want to 

select fields. 

5. In the Available Field list, click on the field you want to include and click the > 

button to move it to the Selected Field list. Do the same for any other field you want 

to move or click the >> button to move all fields at once. 

6. Select another table or query, if desired, and then select the fields you want to use 

from it. 

7. Repeat this step until you include all the fields you need, and click Next. 

8. Access asks whether you want a Detail or a Summery query. Choose which ever 

you want and click Next. 

9. Enter a title for the query in the What Title do you want for your Query? text box. 

10. Click Finish to view the query result. 

 

Note: The Simple Query Wizard simply selects the fields you want to display. You cannot 

set criteria for individual fields and you cannot set sort order.  

 

 To create a select query in Query Design View:  

1. In the database window, click the Queries tab and then click New. 

2. In the New Query dialog box, click Design view and then click Ok. 

3. In the Show Table dialog box, click the tab that lists the objects whose data you 

want to work with.  

4. Double-click the name of each object (Table/Query) you want to add and then close 

the dialog box. 

5. Add fields to the query by dragging or double-click the field names from the field list 

to the design grid. 
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6. To set criteria for a field that you have added to your query, click the criteria row in 

the desired field‟s column and write the criteria.  

7. To sort on a field that you have added to your query, click the Sort row for the field 

you want to sort. From the drop-down list that appears, select Ascending or 

Descending. 

8. To create a calculated field, Click the Field row in a blank field, then use the Build 

button of the toolbar or specify the expression yourself. 

9. To see the results of a query, from View menu, choose Datasheet or click Run 

Query (!) from the toolbar. 

10. Save the query. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SNNPR Capacity Building Bureau 

                              Department of Information Communication Technology                           

-25- 

                    

 

Note: Whenever you add a field to the Design grid, the Show mark is selected, that is it will 

be displayed in the query result. If you do not want a field displayed in the query 

result, uncheck the check mark in its show cell. 

 

B. Parameter Query  

 

  A parameter query is a query that when run displays its own dialog box, prompting you for 

information, such as criteria for retrieving records or a value you want to insert in a field. 

If you frequently run the same select query but you change the criteria each time you run it, 

you can save by creating a parameter query. When you run a parameter query, you don‟t 

have to open the query window and make changes in the QBE grid, instead, Microsoft 

Access prompts you for criteria in the Enter Parameter Value dialog box. For example, if 

you often run a query to find the total number of orders by sales person, you could design a 

parameter query that prompts you for the name of a sales person every time you run the 

query. 

 

 To create a parameter query: 

1. Create a query without using a wizard and add the tables you want. 

2. In query Design View, drag the fields for the query. 

3. In the criteria cell for each field you want to use as a parameter, type a prompt 

enclosed in square brackets. Microsoft Access will display this prompt whenever the 

query runs. The text of the prompt must be different from the field name, although it 

can include the field name. 

4. Choose Datasheet view, from the View menu, or standard toolbar. 

5. Enter a value and then click Ok. 

 

C. Cross tab Queries 

 

It displays summarized values (sums, counts, and averages) from one field in a table and 

groups them by one set of facts listed down the left side of the datasheet and click another 

set of facts listed across the top of the datasheet. 
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 To create a cross tab query without a wizard: 

1. In the Database window, click Queries under Objects, and then click New. 

2. In the New Query dialog box, click Design View, and then Ok. 

3. In the Show Table dialog box, select the tables or queries that contain the fields you 

want to add to your query. 

4. Double-click the name of each object you ant to add to the query, and then click 

Close. 

5. Add the fields to the Field row in the Design grid and specify criteria. 

6. On the toolbar or Query menu, click Query type, and then click Cross tab. 

7. For the field or fields whose values you want to appear as row headings, click Cross 

tab row and then click Row Heading. You must leave the default Group By in the 

total row for those fields. 

8. Click the Cross tab cell for the field from which you want to take summery values, 

click the arrow, and then select value from the list in a cross tab query, you can have 

only one field set to value. 

9. Click the Total cell from which you want to take summery values, click the arrow, 

and then select the type of total you want (such as sum, max, or count) from the list. 

The field you use for values cannot be a Group By field; it must contain a total. 

10. From the View menu, choose Datasheet to see the record set. 

 

D. Action Queries 

 

An action query is a query that makes changes to many records in just one operation. There 

are four types of action queries: make-table, append, update, and delete query. 
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I. Make Table Query 

 

Creates a new table from all or part of the data in one or more tables. Make-Table queries 

are helpful for: 

 Creating a table to export to other Microsoft Access databases. For example, you 

might want to create a table that contains several fields from your employees and 

then export that table to a database used by your personnel department. 

 Making a back-up copy of table. 

 Improving performance of forms, reports, and data access pages based on multiple-

table queries or SQL statements. 

 

 To create a new table from the results of a query with a make-table query: 

1. Create a query, selecting the tables or queries that contain the records you want to 

put in the new table. 

2. In query Design view, click the arrow next to the Query Type on the toolbar, and 

then click Make-Table. 

3. In the Make-Table dialog box, enter the name for the table in the Table Name 

dialog box. 

4. Click Current Database to put the new table in the currently open database. Or 

click Another Database and type the name of the database you want to put the 

new table in. Type the path if necessary. 

5. Click Ok. 

6. Drag from the Field lists to the query design grid, the fields you want in the new 

table. 

7. In the Criteria cell for the fields you have dragged to the grid, type the criteria. 

8. To preview the new table before you create it, click View on the toolbar. To return 

to query Design View, and make changes or run the query, click the View button 

on the toolbar. 

9. To create the new table, click Run button. 
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II. Append Query 

 

An Append query adds a group of records from one or more tables. For example, suppose 

that you acquire some new customers and a database containing a table of information on 

those customers. To avoid typing all these information in, you would like to append it to 

your customer‟s table. Append queries are also helpful for: 

 Append fields based on criteria. For example, you might want to append only the 

names and addresses of customers with outstanding orders. 

 Append records when some of the fields in one table don‟t exist in the other table. 

An append query will append the data in the matching fields and ignore the others. 

 

 To append records from one table to another table using append query: 

1. Create a query that contains the table whose records you want to append to another 

table. 

2. Choose Append Query from Query menu. 

3. In the Table Name box, enter the name of the table you want to append records to. 

4. Click Current Database, if the table is in the currently open database. Or click 

Another Database and type the name of the database where the table is stored. Type 

the path if necessary. 

5. Click Ok. 

6. Drag from the Field list to the query Design grid the fields you want to append and 

any fields you want to use for setting criteria. Also you may not want to add the 

Primary key field, if it has an Autonumber data type. If all the fields in both tables 

have the same names, you can just drag the asterisk (*) to the query design grid. 

However, if you are working in database criteria, you will need to add all the fields 

instead.  

7. If the fields you have selected have the same name in both tables, Microsoft Access 

automatically fills the matching name in the Append To row. If the fields in the two 

tables don‟t have the same name, in the Append To row, enter the names of the 

fields in the table you are appending to. 
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8. In the Criteria cell for the fields that you have dragged to the grid, type the criteria 

on which additions will be made. 

9. To preview records that the query will append, click View menu and choose 

Datasheet. Then switch to Design View and make any changes you want. 

10. Click Run on the toolbar to add the records. 

 

III. Update Query 

 

Update query makes global changes to a group of records in one or more tables. For 

example, you can raise prices by 10 percent for all dairy products, or you can raise salaries 

by 5 percent for the people with in existing tables. 

 To change records as a group using update query:  

1. Create a query, selecting the tables or queries that include the setting criteria. 

2. In query Design view, click the arrow next to Query type on the toolbar, and then 

click Update Query from Query menu. 

3. Drag from the Field list to the Query Design grid the fields you want to update or 

you want to specify criteria. 

4. In the Criteria cell, specify the criteria if necessary. 

5. In the Update To cell for the fields you want to update, type the expression or value 

you want to use to change the fields. 

6. To see a list of records that will be updated, click View on the toolbar. This list will 

not show the new values. To return to query Design View, click View on the toolbar 

again. Make any changes you want in Design View.  

7. Click Run on the toolbar or Query menu to update the records. 

 

IV. Delete Query 

 

Deleting a single record from a table is quite easy. You open the table in Datasheet view, 

locate the record you want to eliminate, and click to the left of the row containing the list of 

the record to be deleted. Thus high lights the row, and pressing the Delete key on your 

keyboard eliminates the record.  
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Delete query deletes a group of records from one or more tables. For example, you could use 

a delete query to remove products that are discontinued or for which there are no orders. 

With delete queries, you always delete entire records not just selected fields with in records. 

 

 To delete records from one table(s) in one-to one relationships: 

1. Create a new query that contains the tables from which you want to records. 

2. In query Design view, choose Delete Query from Query menu. 

3. From the table you want to delete records from, drag the Field list in to the   query 

design gird. From appears in the delete cell under these fields. 

4. To specify criteria for deleting records, drag to the design girds that fields on which 

you want to set criteria. Where appears in the delete cell under these fields. 

5. In the Criteria cell for the fields that you have dragged to the gird, type the criteria. 

6. To preview the records that will be deleted, click View on the toolbar. To return to 

query Design view, click View on the tool bar again. Make any change you want in 

Design View. 

7. Click Run on the tool bar to delete the record.   

 

10.2 Using Expressions in Queries and Filters 

 

To limit your query‟s dynaset, to certain records, you specify criteria for the query. For 

example suppose that you want to view only the suppliers from France. You specify a 

criterion that limits the records to those whose country filed is        “France”. Only records 

that meet your criterion are included in the dynaset.  

 

When you specify criteria for a query, you use an expression. An expression tells Microsoft 

Access which records to include in the query‟s dynaset. To create an expression, you can 

either type the expression directly into the QBE grid or use the Expression Builder. With the 

Expression Builder, you can select the components of your expression from lists, and the 

Expression Builder creates your expression for you. 
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* To specify criteria for a field, in the criteria cell for the field, type an expression  or use an 

Expression Builder. 

 

Some criteria examples. 

 

Field Expression  Return 

ShippCity “London” Displays orders shipped to London. 

Ship City “London” or “Hedge End” use the Or operator to display orders 

                              Shipped to London or Hedge End. 

 

Shipped Date Between 1/5/95 Uses the Beween…And operator to  

 And 1/10/95 display orders no earlier than 5-Jan- 

  95 and no latter than 10-Jan-95. 

 

Shipped Date 3/6/95 Displays orders 6-Mar-95 

Ship Country In(“Canada”,”UK”) uses the In operator to display orders  

  shipped to Canada or UK. 

 

Shipped Country Not “USA”   uses the Not operator to display orders  

 shipped to countries other than USA. 

 

Ship Name Like “S*” Orders shipped to customers whose.

  

  name starts with the letter S. 

 

Company Name >=”N” Displays orders shipped to  

   Companies whose name starts with 

 the letter N through Z. 
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Note: you can specify criteria for more than one field in the criteria row. 

1. If you are looking for records that meet both criteria, place both criteria on the 

same line (row). 

2. If you are looking for records that meet one of the two criteria, place the criteria 

on different lines (rows). 

 

10.2  Performing Calculations in Query  

 

    Using the Total row in query Design view, you can calculate the sum, average, count, 

minimum, maximum, standard deviation or variance, values in one or more fields either 

for all the records in a query or for one or more groups of records.  

 

 To calculate a sum, average, count, or other total on all the records in query: 

1. Create a select query in Design view. Add the tables whose records you want to 

use in the calculation, and then add the fields on which you want to perform 

calculations and specify criteria. 

2. Click Totals   on the toolbar. Microsoft Access displays the Total row in the 

design grid. 

3. For each field in the design grid, click its cell in the Total row, and then click on of 

the following aggregate functions; Sum, Avg, Min, Max, Count, stdev, or var.   

4. If you want, enter criteria to affect the results of the calculation.  

5. If you want sort the results.  

6. Click View on the toolbar to view the results.   

 

 To calculate a sum, average, count, or other total on groups of records in a query: 

1. Create a select query in design view. Add the tables whose records you  

       want to use in the calculation, and then add the fields on which you  

       want to perform calculations, define groupings, and specify criteria.  

2. Click Totals on the toolbar. Microsoft Access displays the total row in 

      the Design grid.  
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3. For the field or fields you want to group on, leave Group By in the  

      Total cell. 

4. For each field you want to calculate, click its cell in the Total row and  

      then click one of the following aggregate functions: Sum, Avg, Min, 

     Max, Count  stdev, or var. 

5. If you want, enter criteria to affect the results of the calculation.  

6. If you want, sort the results.  

7. Click View on the toolbar to view the results. 

 

11. Forms 

 

     You can do all your data entry and editing in a table but that may not be the best way. 

Most people find it easier to create a special on-screen form in which to enter the data. A 

form resembles any fill-in-the-blanks sheet that you might complete by hand, such as a job 

application. Microsoft Access links the form to the table and stores the in formation you put 

in to the form in the table.  

 

Forms let you view, enter edit, and print data in a way that is easier to use than a datasheet. 

You use Forms to present or input one record and many records at a time.   

  

In Access, you can attach instructions with Forms to be used during data entry. You can 

include buttons for making multi-choice entries, Formats for validations of data to prevent 

erroneous entries, and so on. Variety of design elements such as titles, pictures, lines and 

color can be used in creating forms. And these are the major advantages of using Form than 

a Table or a Datasheet. Among the purposes of Access Forms, the followings are the major 

ones. 

 

o Produce present a form that looks like a paper form you are familiar with. 

  

 


